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SIFT > Pre-processing
Model fitting and validation »

Locate dipoles using DIPFIT 2.x > Connectivity

Peak detection using EEG toolbox Statistics > A llO
FMRIB Tools > | Visualization =
e NO Locate dipoles using LORETA = [
File Edit Plot  Study Datasets Help
__Datasets 1,2
Groupname: - (soon)-
Number of datasets 2 P '
Dataset type epoched re_proceSS|ng
Epoch consistency ves
Channels per frame 152
Channel ceonsistency ves 144+
Channel locations ves MOdel .I:lttlhg Z
Events (total) 979 and \/a|ldat|0n O
Sampling rate (KEz) 256 Q
ICA weights ves CD
Identical ICA no . — g
Total size (Mb) 368 COnneCJﬂVIty (8
V4

Statistics

Group Analysis Visualization
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Starting

EEGLAB/SIFT

SIFT Requirements:

e Matlab 2008b or later

* Signal Processing Toolbox
* Statistics Toolbox
e EEGLAB
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Starting

EEGLAB/SIFT

'ig Edit Debug Parallel Desktop Window Help

New - l[ﬂ F] @ Current Folder:
Open... ®0
s 2| STARTTCE 2] SIFT Sta
Close Command Window #W L"‘J 4 4 |
er ‘

Import Data... -0l @ B

Save Workspace As... #®S 'f —— ——

Set Path. . ! File Folder
File Folder

Preferences... 8, File Folder

int...

Print . %P File Folder

Print Selection... &P File Folder

1 ...st/est_fitMVARKalman.m g!:e §°::e'

2 /Users/...r/mvar_glADMM.m F:|: Fgl d::

3 /Users/...minimal/mvaar.m File Folder

4 [Users/.../mvar_dalSCSA.m File Folder
File Folder

Exit MATLAB #Q File Folder

™ = lost+found File Folder

» [ User Guides And Information File Folder

> L sw File Folder

» L tmp File Folder

» L] usr File Folder

» ] Developer File Folder

» var File Folder

» | bin File Folder

» o Library File Folder

» |_sbin File Folder

» | ]etc File Folder .

3 dev File Folder

. Annliratinne File Fnlder
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|. Clear the Matlab Path

All changes take effect immediately.
MATLAB search path:
( AddFfolder.. ) B

( Add with Subfolders... ) (] /Users /timmullen/Documents /WORK/Conference:*
(] /Users /timmullen/Documents /WORK/Conference:
&Y /Users/timmullen

(L] /Users/timmullen/Documents /WORK/Conference:
(] /Users/timmullen/Documents /WORK/Conferences

(] /Users/timmullen/Documents /WORK/Conferences
[ /Users /timmullen/Documents /WORK/Conference:

(] /Users/timmullen/Documents /WORK/Conferences '
Move to TOp " Q,Usefs “" - ""“' —_—
G fusers @9 00 (7 Set Path
Move Up v Gl /use

t Move Down ) g ;3:: Do you wish to restore the default path?
If you do so, you will lose your current path settings.

(__MovetoBottom ) o

(] /Users
[ /use
L /use

L /use
( No )|C Yes )

 fUse

(] /Users
QIUseulﬂmm Doc s IWORK/Con
g i 0 : : . nces ¥
( Remove ) == immulien/Documents /WORK /Lo Ll__L
2 ( Save ) (( Close ) ( Revert




Starting

EEGLAB/SIFT

2. Add EEGLAB+SIFT to path

W

( Add Folder...

)

{ Add with Subfolders... )

Move to Top

Move Up
( Move Down )
( MovetoBottom )
( Remove 3

—
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All changes take effect immediately.

MATLAB search path:

- /Users/timmuIlcn/Documents/WORKlConfercncce ’
. /Users/timmullen/Documents /WORK/Conference:

L /Users/timmullen/Documents /WORK/Conference:

4 /Users /timmullen

Q/Users/ummullenloocum (4 >] (
1 /Users /timmullen/Documi -

<USB Key>/SIFT/eeglabl0 2 5 5a/

=N l]]]] [ﬁ eeglab10_2_5_5a

B

7

1 /Users /timmullen/Documi

G /Users/timmullen/Documy ¥ DEVICES

m

_M Date Modified

(L /Users/timmullen/Documi B TimMullenMacBook ~ 1ST_README.txt 9/10/11
&l /Users/timmullen/Documi = ml Contents.m 9/10/11
G /Users/timmullen/Docum =) iDisk
& /Users timmullen/Documi =4 |00 m| eeglab.m 12/31/11
& /Users/timmullen/Docum eeglablicense.txt 9/10/11
{ /Users /timmullen/Documi _—
&l /Users timmullen/Documi | 1 \RED Q) » [ external 4:02 PM
g /U"'S/“mmu::‘"loﬂum I arno's MacBook Pro » [ ] functions 4:02 PM
/Users /timmullen/Documi - )
(i /Users /timmullen/Documi Bl MakeigMacBook1 (5) » [ plugins 4:02 PM
g /Users/!immu::enloocum ¥ PLACES = m sample_data 9/10/11
/Users /timmullen/Documi .
0 /Users/timmullen/Documi  « Ideas.rtf » [] sample_locs 9/10/11
(1l /Users /timmullen/Documi untitled~ 9/16/11
r timmullen]Docuﬂ%t ﬁtemp
. [] Toolboxes
save ) ( Close ) (] WORK

(] WORK 2

(] SIFT v

( New Folder ) ( Cancel ) G-Mll-)




Starting

EEGLAB/SIFT

3. Start EEGLAB

X a2 = [ Command Window

fx >> eeglab
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Starting

EEGLAB/SIFT

gat e e 4. Check EEGLAB memory options

Import data >

Import epoch info - -8 00O Memory options - pop_editoptions()

Import event info 3

Export >

Load existing dataset fpd STUDY options (set these checkboxes if you intend to work with studies)

Save current dataset(s)

Save current dataset as If set, keep at most one dataset in memory. This allows processing hundreds of datasets within studies.
Clear dataset(s) If set, save not one but two files for each dataset (header and data). This allows faster data loading in studies.
Create study & If set, write ICA activations to disk. This speeds up loading ICA components when dealing with studies.
Load existing study Memory options

Save current studh

Save current Szud: as If set, use single precision under Matlab 7.x. This saves RAM but can lead to rare numerical imprecisions.
Clear study If set, use memory mapped array under Matlab 7.x. This may slow down some computation.

Memory and other options If set, use the EEGLAB EEG object instead of the standard EEG structure (beta).

History scripts 3 ICA options

Quit If set, precompute ICA activations. This requires more RAM but allows faster plotting of component activations.
If set, scale ICA component activities to RMS (Root Mean Square) in microvolt (recommended).

Folder options

If set, when browsing to open a new dataset assume the folder/directory of previous dataset.

Toolbox options

If set, do not use Matlab additional toolboxes functions even if they are present.

EEGLAB chat option

If set, enable EEGLAB chat - currently UCSD only - restart EEGLAB after changing that option.

U 0 0 @ @aa 000 oad %

Option file: ~/eeg_options.m

(_Hep ) ( Cancel J Ok )
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2

Loading Data

B RespCorrect.set

. Date Modified

Wednesday, June 13, 2012 11:23 AM

- RespWrong.set Wednesday, June 13, 2012 11:23 AM

Saturday, June 16, 2012

File Format: | (*.SET*, *.set) 4]

Import data
Import epoch info

Import event info
Export

Load existing dataset
Save current dataset(s)
Save current dataset as
Clear dataset(s)

Create study - .

Load existing study
Save current study
Save current study as
Clear study

Memory and other options
History scripts =
Quit

fcontinuous




2  Loading Data

9.0

File Edit

__Datasets 1,2 v Dataset 1:RespCorrect
v Dataset 2:RespWrong

Groupname: - (socon)-
Number of datasets

Dataset type

Epoch consistency ves
Channels per frame 152
Channel consistency ves
Channel locations ves
Events (total) 2083
Sampling rate (Hz) 2586
ICA weights ves
Identical ICa no
Total size (Mb) 624.3

Y/
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Preprocessing

Fil

Help

Change sampling rate

Filter the data

Re-reference

Interpolate electrodes

Reject continuous data by eye

Extract epochs
Remove baseline

Run ICA
Remove components

Automatic channel rejection
Automatic epoch rejection
Reject data epochs

Reject data using ICA

Locate dipoles using DIPFIT 2.x
Peak detection using EEG toolbox

FMRIB Tools
Locate dipoles using LORETA

vy

¥ Miscellaneous
VerbosityLevel

¥ Data Selection

v SelectComponents

EpochTimeRange
TrialSubsetToUse
¥ Filtering
NewSamplingRate
FilterData
DifferenceData
¥ Detrend
DetrendingMethod
v Piecewise
SegmentLength
StepSize
Plot
AmplitudeEnvelope
¥ Normalization
¥ NormalizeData
Method

ComponentsToKeep

8;11; 13; 19; 20; 23; 38; 39

linear

=
™
™

(O

£

time; ensemble

0.33
0.082

ComponentsToKeep

IDs of components you wish to keep

Select components to analyze. This should be a cell array of strings containing the

Pre-processing

Model fitting and validation »
Connectivity

Statistics I+
Visualization B

Saturday, June 16, 2012
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v
1 Algorithm Vieira-Morf
Se I eCtl On WindowlLength 0.4

WindowStepSize 0.03
NormalizeData
v Detrend
DetrendingMethod constant
ModelOrderRange [130]
Downdate
InformationCriteria sbc; aic; hq; ris
¥ Data Selection
WindowSamplePercent 80
¥ Miscellaneous
¥ PlotResults V)
OptimalModelSelectionMethod min
Change sampling rate PercentileLimits 90

Filter the data [ VerbosityLevel 2
Re-reference

4 M O d e I O I"CI e r v Mod;Iing Ié’ara:me.ters

Eim

Study Datasets Help

Plot

Group

. Int.erpolate.electrodes
araser] Reject continuous data by eye
Epoch

Extract epochs
Remove baseline

ModelingApproach

Channel Run ICA Select a modeling approach and define parameters. Make sure to
Events Remove components use the same parameters you intend to use for the final modeling
Ssampli step.

1ca weid Automatic channel rejection

Automatic epoch rejection [ Help ] [ Cancel ] [ OK J
Reject data epochs
Reject data using ICA

v

v

Pre-processing |
Model fitting and validation »

Model Order Selection

Locate dipoles using DIPFIT 2.x I

, , Connectivity Fit AMVAR Model
Peak detection using EEG toolbox Statistics > Validate model
Visualization > |

FMRIB Tools >
Locate dipoles using LORETA I [
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Model Order

4 :
Selection

Saturday, June 16, 2012
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el
File Edit

View

» Dddae R

Insert  Tools

Des!

ktop

LAY - A 08 D

Mean Info, Cnteria across sampled windows
Optmal order determined by min of mean curv

by
9
-
-

g 13 1 4 L 1 T 13 14 L 4 L 1 1 ] T 13 L 4 L 1 T T T L 4 L 1
) [ I — 0 (5)
@ [ 1 ak (30)
I i — h3(14)
B [ I e 183 (5)
S 6= : :
-
¢ : ——
F=200 .5 3 "UN N R A AR B B N A B B R AR A T A I B B D B B B B S R |
£ 12 34 5 86 7 8 9 1011121314 1516 17 18 19 20 21 22 23 24 25 26 27 28 29
model crder
sbc aic
»S 20 P
| g s,
8 3
g s 10
2 2 s
w )
£ ne - 0 B
10 20 N 0 10 20 0
opt model order opt moded order
hgq ris
20 1405 =
£ s : 5 ;
8 3
gw 5
- s g “
"] [
= o “~ X
10 20 k)

File Edit

opt model order

opt moded order

e
File Edit

View
» Ddde R NN '?S‘Hé]' Q 068 =0
Meaan Info. Critana across sampled windows
Optimal order determinad by min of mean curv
E ‘J ] ] I 1] 1] L] 1 1 I ] | 1] 1] 1 1 Ll Ll L L L T ] )
o 1 —rc(4)
@ I ak (30)
I3 1 —— (13
b 1 e 185 (4)
g i —$—
1 1
g !
S goL | | | | ' L | | | | | ' | | | | | | | I I I | |
k- 1 2 3 4 5S 6 7 8 9 1011 121314 1516171819202 2223425262789 N
model order
sbec aic
40
2 2 0.
5 g 20.
2 2.
®* 2
= & 0 |
10 20 30 0 10 20
opt model order opt model order
hq ris

20 ] :
B s |
8 8

10.-
: :
o S. O
G G
£, - -

0 10 20 30 10 20 3

Insert Tools Desktop Window Help

rg

opt model order

opt model order

View

Insert Tools Desktop Window
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hq
20" T \J A | | |
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8
£ 10-
©
S 8-
2
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4 -
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1
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opt. model order

Do you want to proceed to model fitting?
A Model-fitting GUI will be generated for you based on the options you selected above

W
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Model Fitting

¥ Modeling Parameters

Algorithm Vieira-Morf
WindowLength 0.4
WindowStepSize 0.03
EpochTimeLimits ]

WindowSamplePercent 100

¥ Window Preprocessing

Plot Study Datasets

Help NormalizeData =
Change sampling rate ¥ Detrend W
[ Filter the data > DetrendingMethod constant
¥ Miscellaneous
o Re-reference Timer 0

Interpolate electrodes VerbosityLevel 2
Reject continuous data by eye

Dataset
m:e ModelOrder
Extract epochs VAR model order.
Channel¥  pemove baseline
Channel
Channel Run ICA
Events Remove components Help Cancel OK
Sampli

Automatic channel rejection
Automatic epoch rejection
Reject data epochs

Reject data using ICA

v

\ 4

e

Pre-processing |
Model fitting and validation »
Connectivity

Statistics S
Visualization > |

Model Order Selection
Fit AMVAR Model
Validate model

Locate dipoles using DIPFIT 2.x I
Peak detection using EEG toolbox

FMRIB Tools >
Locate dipoles using LORETA I [
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Model Fitting
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Model

Validation

Pre-processing
Model fitting and validation »

Model Order Selection

Connectivity Fit AMVAR Model
Statistics [ alidate mode
Visualization I+

checking whiteness (5/148)...
Condition: RespCorr

checking stability ( 38148)...
Condition: RespCorr

Saturday, June 16, 2012

Y e
Bz#s.s@iﬁh

¥ Validation Methods

Whiteness criteria. These are the statistical tests used to

Help Cancel

test for uncorrelated residuals
| OK |

v CheckResidualWhiteness V)
SignificancelLevel 0.05
MultipleComparisonsCorrection none
NumberOfAutocorrelationLags |
™ Ljung-Box
CheckConsistency B ™ ACF
CheckStability 4 ™ Box-Pierce
¥ Data Reduction M Li-McLeod
WindowSamplePercent 70
¥ Miscellaneous Cancel
I ok )
PlotResults R4 [[Tp—
WhitenessCriteria




S
-

Whiteness Signifcance

e
~

Model

Validation

View Insert Tools Desktop Window Help
NEdse h CLO9QE- A 08 D

—e— L jung-Box (44148 white)

——e— ACF (4848 whie)

e Box-Pierce (4448 whie)

e LiMcLeod (448 white)
-

View

Sde h ALNO9QL- 2 08 D

b
C

S
L

Whikness Signifcance

e
~

ACEF statistic should be above this line

Portmanteau statistics should be above this line

Insert Tools Desktop Window

—e— Ljung-Box (4648 white)
e ACF (42048 whie)

e Box-Plorce (4 7148 white)
—e— Li-McLeod (4648 white)
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Connectivity

|24
_ Pre-processing
.~ Model fitting and validation

Locate dipoles using DIPFIT 2.x

>

Peak detection using EEG toolb o

ead etection using C toolIboX Statistics >
FMRIB Tools > Visualization >
Locate dipoles using LORETA > |

OO Connectivity Estimation
This operation will require 2.6562 MB of memory (per condition).

Make sure you have enough memory available.
Do you want to continue?

=

estimating connectivity for RespCorr (25/68)...

Saturday, June 16, 2012

|

¥ Connectivity Estimation -
(] DTF
¥ Options
SquaredModulus 4 g :g:l;
ConvertSpectrumToDecibels W —
Frequencies 1:40 g dDTFO8
¥ Miscellaneous D ffDTF
VerbosityLevel 2 [ lpDC
W nPDC
ConnectlvltyMeasure's ~ GPDC
Select measures to estimate. =) PDCF
Measures are categorized as follows: _] RPDC
+ DIRECTED TRANSFER FUNCTION MEASURES (] GGC
DTF: Directed Tranfer Function [ ] Coh
nDTF: Normalized DTF ] iCoh
dDTF: Direct DTF H pCoh
dDTFO8: Direct DTF (with full causal normalization) H mCoh
ffDTF: Full-frequency DTF

+ PARTIAL DIRECTED COHERENCE MEASURES
PDC: Partial Directed Coherence
nPDC: Normalized PDC
CPDC: GCeneralized Partial Directed Coherence
PDCF: Partial Directed Coherence Factor
RPDC: Renormalized Partial Directed Coherence
+ GRANCER-CEWEKE CAUSALITY MEASURES
CCC: Cranger-Geweke Causality
+ SPECTRAL COHERENCE MEASURES
Coh: Complex Coherence
iCoh: Imaginary Coherence
pCoh: Partial Coherence
mCoh: Multiple Coherence
+ SPECTRAL DENSITY MEASURES
S:  Complex Spectral Density

;
w

Cancel

E_

" Help \ | Cancel \ | OK \

[




Visualization of a single

8

condition

Select RespVWrong dataset only

0060 EEGLAB v10.2.5.5b
File Edit Tools Plot Study BEIEHLE m

#2: RespWrong Dataset 1:RespCorrect

v Dataset 2:RespWrong

Filename: ...inqg/SIFT/Data/RespwWro Select multip|e datasets
Channels per frame 152 ’
Frames per epoch 576

Epechs 123

Events 498

Sampling rate (Hz) 2586

Epech start (sec) -1.000

Epech end (sec) 1.24¢

Reference unknown

Channel locatiens Yes

ICA weights Yes

Dataset size (Mb) 184

Saturday, June 16, 2012
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Visualization:
Time-Frequency Grid

8

Locate dipoles using DIPFIT 2.x
Peak detection using EEG toolbox

FMRIB Tools
Locate dipoles using LORETA

Pre-processing

Model fitting and validation »
* | Connectivity

Statistics >
> Visualization > Time-Frequency Grid
> | BrainMovie3D

Saturday, June 16, 2012

Causal Projection

Aj ¢ @b @Y
2y ;.z =y B

¥ DisplayProperties
¥ MatrixLayout
UpperTriangle
LowerTriangle
Diagonal
ColorLimits
TimesToPlot
FrequenciesToPlot
PlotContour
PlottingOrder
SourceMarginPlot
Nodelabels
EventMarkers
FrequencyScale
Colormap
¥ Thresholding
¥ Thresholding
PercentileThreshold
AbsoluteThreshold
¥ DataProcessing
Baseline
Smooth2D
¥ Miscellaneous
DipolePlottingOptions
¥ FrequencyMarkers
FrequencyMarkers
FrequencyMarkerColor
» TextAndFont

Partial

dDTFO8

dDTFO8

S

99.7

[-0.80078125 1.03125]
[1:40])

0
dipole

{'g', '11','13', '19', '20...
{0, 'r", "', 21}
linear

[0 0 0.506666666666...

Simple
[97.5 3]
(

-1 -0.25]

—

[3715]
(0.7 0.7 0.7]

(Name)
(Description)

L *

20



oSN A Figure 3: Subj eb79. Cond (RespWrong)

File Edit View Insert Tools Desktop Window Help

Granger Causality on off-diagonal
ERSP on diagonal

11 13 S 20
upper. dDTFOE

8
/\ - 28N\ : /\
- 0 0 o o
lower: dDTFOE

H5 0 05 1

ZH) Aouenbauy

O 0 05 1 L

1 :
Time (sec)
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806 Figure 3: Subj eb79. Cond (RespWrong)

File Edit View Insert Tools Desktop Window Help
> d 2 L ¢ DL & 0 E3 -

-

upper: dDTFOE

"N 5 /\
diag: @
ower dDTFOE

) Figure 5: Subj eb79. Cond (RespWrong).
@" File Edit View Insert Tools Desktop Window Help

R i de b RAO9DEE- 2 0E
@\ 4Soubj eb79. Cond (RespWrong).

@ < 30

1C8 = IC19

ZH) Aduenbauy

Time (sec,

1C19 = 1C8

Time (sec
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ANN

Figure 6

O NO

Figure 5: Subj eb79. Cond (RespWrong).

File Edit View Insert Tools Desktop Window Help | File Edit View Insert Tools Desktop Window Help

Increase in event-related

» NEde h CSLO9RE- 2 08 D : ,
%0 , information flow from
Subj eb79. Cond (RespWrong). .
ol _ - ;2= S Event . ica =icis] Ji° ™ |C8 -> IC19 relative to
“ (4 . baseline. This pixel indicates
& Ch & -—.—-4 increased GC at 5 Hz and
N2 o & ' - 0.5 seconds following the
bt x 10 - o '
8’ 2 IC8 = Ti(r)ne (soc L2 12:19 event
st <L g ’ IC19 > IC8
ac y e Edit View Insert Tools Desktop Window Help
10 5 20 i - 1Sde h ¢ 9V 2 08 =@
i 10t
5 Qi S = = == -0.00
L -3M80‘3
X100 05 0 05 1
Time (sec
\ -
eNO Figure 7 4
‘ File Edit View Insert Tools Desktop Window Help
19
Frequency- ..............................
: 10.04
varying net GC
(integrated over time) 1002

A
| X

Baseline Time-varying net Granger causality
(integrated over frequency)
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SN O Figure 3: Subj eb79. Cond (RespWrong)

File Edit View Insert Tools Desktop Window Help
> d 2 L ¢ DL & 0 E3 -

";1‘

diag: S '. ‘ - ) (/\

ower: dDTFOE eSO Figure 9: Subj eb79. Cond (RespWrbng).
@\. File Edit View Insert Tools Desktop Window Help
o : de b RAUDLEA- 2 0F

@\ 4Soubj eb79. Cond (RespWrong).
> ,." ’ 3‘

upper: dDTFOE

&

ZH) Aduenbauy

Event-related Spectral
Perturbation

Time (sec;
Time (sec)
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9 Visualization:

Causal BrainMovie3D

Pre-processing

Model fitting and validation »

Locate dipoles using DIPFIT 2.x > Connectivity
Peak detection using EEG toolbox Statistics

FMRIB Tools N Visualization

>

Time-Frequency Crid

Locate dipoles using LORETA >

Facelighting
UseOpenCL
EvermMarkers
FlashEvemts
DisplayLegendPanel
DisplaylegendLimiuText
ShowlLatency
DisplayRTProbability
BackgroundColor
v GraphColorAndScaling
NodeSizeLimits
NodeColorLimits
EdgeSizeLimits
EdgeColorLimits
NodeSizeDataRange
NodeColorDataRange
EdgeSizeDataRange
EdgeColorDataRange
CenterDataRange
EdgeColorMap
NodeColorMap
DiskScalingFactor
MagnificationFactor
» OutputFormat
mri
ShowMRISlices
DipoleCoordinateFormat
DipplotOptions
BrainMovieSuppOptions
¥ Thresholding
UseStatistics
PercentileThreshold
AbsoluteThreshold

FooterPanelDisplaySpec

Saturday, June 16, 2012

BrainMovie3D

Causal Projection

phong
“0. 0{1' 0:0'

~N
—
—

JRR®AC)

[000)

[0.11]
[0 1]
[0.11]
[0 1]

SO0

jet(64)
jer64)
0.3

standard_BEM_mri.mat
-

spherical

{}

{}

J

0.05 »
N v

Configure footer panel displayed at the bottom of the figure. If i
‘off', don't render footer. If 'ICA_ERP_Envelope', then display the S
ERP envelope of backprojected components. If v

BN BrainMovieD Control Panel

8 [m =

¥ DataProcessing

ConnectivityMethod dDTFOB
MovieTimeRange [-0.80078125 1.031...
FrequenciesToCollapse [3:7]
FreqCollapseMethod integrate
TimeResamplingFactor - 0
SubtractConditions )
Baseline 1

¥ DisplayProperties

v ShowNodelabels 4

Nodelabels 8§1113192023383

NodesToExcude
EdgeColorMapping Connectivity
EdgeSizeMapping Connectivity
NodeColorMapping CausaIFlow
NodeSizeMapping

v

8: 11; 13; 19; 20; 23...

Baclu’rojecﬂ’oChans Al A2, AB, A7, A8 A ..
PlotMode all; envelope
¥ BrainMovieOptions

ImageSize (800 800)
Visibllity on
ShowCameraMenu L)
RotationPath3D L
InitialView [122 30)
MakeCompass
ProjectGraphOnMRI off

¥ Theme

theme classic

¥ Layers
» Scalp ™

Skull B

CSF ()

v Cortex 4
Resolution high
Transparency 0.9
v Color LONI_Atlas
Color {‘jer'}

CustomMesh O .
Facelighting phong h
Lieafanall ~-

FooterPanelDisplaySpec

Configure footer panel displayed at the bottom of the figure. If i
"off', don't render footer. If 'ICA_ERP_Envelope', then display the N
ERP envelope of backprojected components. If M

|

- Preview BrainMovie
Select a time point to image (click to refresh)
| (o) I
-0.80078 0.101562 1.03125
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eNO

' |_sualliat|dh

BrainMovie3D Control Panel

ﬂ,'—

Figure 9
Desktop Window Help

View

d 2

Insert Tools

[:& ’

Mov File Ednt’

-
3¢

RespWrong
dDTFO08 (3-7H2

FooterPanelDisplaySpec

Configure footer panel displayed at the bottom of the
If 'off', don't render footer. If 'ICA_ERP_Envelope',
then display the ERP envelope of backprojected

figure.

= Aj A =
.- 2* &= .' LA

-.Y

DataProcessing
ConnectivityMethod
MovieTimeRange
FrequenciesToCollapse
FreqCollapseMethod
TimeResamplingFactor
SubtractConditions
Baseline
DisplayProperties
ShowNodelLabels
Nodelabels
NodesToExclude

EdgeColorMapping Connectivity
EdgeSizeMapping Connectivity
NodeColorMapping CausalFlow
NodeSizeMapping Qutflow 5
ICs 8;11; 13;19; 20, 0 -
BackProjectToChans Al; A2; AB; A7 A8;
PlotMode all; envelope
BrainMovieOptions A
ImageSize (800 800]) v

Preview BrainMovie

Selact a tima noint Lo+

-0.8007

Help

dDTFO8

(-0.80078125 1.0... ||
(3:7) ’
mtegrate ’

connec fiv |t f

“ U -
4

§1113 192023 38 . 0.0

C

Back-projected ERPs: [IC 8,11,13.. | > [Chan A1, A2 A

dolf

Ol Jm'_vl‘n

aoe (click to 0 . . - & . S
<« » P 5
0.101562 1.03125 0.8 06 o 2.2 - n':
Time (sec)
Cancel Make Movie!
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|0 Additional Exercises

1. Explore changing some of the Time-Frequency Grid parameters. Try plotting the TF-Grid with
logarithmic frequency spacing (option: FrequencyScale). Change the SourceMarginPlot to “topoplot” to
see your ICA topographic plots.

2. Explore different parameters for the BrainMovie3D. What is different between delta (1-3) and theta (3-7)
band connectivity?

3. Select both RespWrong and RespCorrect conditions in EEGLAB (Datasets-->Select Multiple Datasets).
Create a Time-Frequency Grid. Choose to the plot the difference RespWrong-RespCorrect (option:
PlotConditionDifference->ConditionOrder) with the dDTF08 on the Upper and Lower Triangle and ERSP
on the diagonal.

4. Recompute connectivity for the RespWrong condition, selecting the Coherence (Coh) and Partial
Coherence (pCoh) methods in addition to the original nPDC, nDTF, dDTF08, and S methods. Create a
Time-Frequency Grid laying out Coherence (Coh) on the UpperTriangle, Partial Coherence (pCoh), on the
LowerTriangle and the ERSP (S) on the diagonal. Use a baseline of [-1 -0.25]. What is different between
coherence and partial coherence? Create another Time-Frequency Grid with dDTF08 on the Upper and
Lower Triangles. What is different between coherence and dDTF (Granger-Causality)?
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Visualization of

condition differences

Select RespWrong and RespCorrect datasets

- J LU
e e AN N AT I AT A

Tools Plot Study EBEICHIE m

Edit

File

__Datasets 1,2 v Dataset 1:RespCorrect
v Dataset 2:RespWrong
Groupname: -(soon)- Select multiple datasets

Number of datasets

Dataset type
Epech ceonsistency ves
Channels per frame 152
Channel consistency ves
Channel locatioens ves
Events (total) 2083
Sampling rate (Hz) 256
ICA weights ves
Identical ICa no
Total size (Mb) 624.3
/
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Visualization of

condition differences B =
¥ DisplayProperties
¥ PlotConditionDifference 4
Pre-processing ¥ MatrixLayout Partial
Locate dipoles using DIPFIT 2.x » g::;'ef:‘:::s SERSGion UpperTr.iangle dDTFO8
Peak detection using EEG toolbox Statistics > LowerTriangle dDTFO8
mp— n Diagonal S
Locate dipoles using LORETA > 8_rai"M°Vie3D ColorLimits 99.7
Causal Projection ) TimesToPlot [-0.80078125 1.03125])
FrequenciesToPlot [2:40]
PlotContour =
PlottingOrder (]
SourceMarginPlot dipole
Nodelabels {'g', '11','13','19', '20...
EventMarkers {{o, 'r', "', 21
FrequencyScale linear
Colormap jet(300)
¥ Thresholding
¥ Thresholding Simple
PercentileThreshold [97.5 3]
AbsoluteThreshold (]
¥ DataProcessing
Baseline [-1-0.25]
Smooth2D =
¥ Miscellaneous
DipolePlottingOptions
» FrequencyMarkers
» TextAndFont
ConditionOrder
Order in which to take difference.
[ Help ] [ Cancel ] [ OK ]
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eSNO Figure 10: Subj eb79. Cond (RespWrong) - (RespCorr).
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eNO Figure 10: Subj eb79. Cond (RespWrong) - (RespCorr).
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Figure 3: Subj eb79. Cond (RespWrong) - (RespCorr).
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ANO Figure 6
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eNOo Figure 3: Subj eb79. Cond (RespWrong) - (RespCorr).
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eNO Figure 10: Subj eb79. Cond (RespWrong) - (RespCorr).
File Edit View Insert Tools Desktop Window Help

- ide B WXL @ 0E |t

upper: dDTFO8
diag: 5

lower: dDTFOS

o M O

Figure 8: Subj eb79. Cond (RespWrong) - (RespCorr).
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